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Autodesk Inventor software is a great tool for building complex mechanical assemblies,
and Autodesk 3ds Max Design software is a great tool for generating visually stunning rendered
animations. This hands-on labs fuses the two programs and covers topics related to the animation of
Inventor assemblies using 3ds Max 2014. You learn how to import an Inventor assembly that will be
used for animation in 3ds Max. You also learn strategies for building a hierarchy based on the animation
requirements for the imported models. The class steps you through the process of creating keyframe
animation of specific moveable parts. Finally, you learn about the tools that are available for editing
keyframes and tweaking the overall look and timing of the animation. To complete the process, you learn
how to configure and render an image sequence for final output using the Quicksilver hardware
renderer.

Learning Objectives
At the end of this class, you will be able to:


Import an Inventor model from within 3ds Max Design 2014.



Create a hierarchical structure that is suitable for animating.



Animate using keyframe animation and edit the keyframes to modify the animation.



Render the animated sequence using the Quicksilver hardware renderer.
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Step by Step
1. In the application menu, choose the Manage option, and choose set project directory.
2. Navigate to the AV1265-L - 3ds Max Project directory, and set it as the current project
directory.

Loading a Starting Scene
3. From the Quick Access Toolbar, click Open.
4. Open the file, Airport_Runway.max.

Import Settings
5. From the Application menu, click Import.
6. Open the import/MV-22 directory.
7. Select the "MV-22.iam" assembly file, and click import.
8. Make sure to select Import As: Meshes.
9. Keep the Reference Duplicate Parts and the Create Layers by Material options checked.
10. Set the Merge/Replace option to Merge with Current Scene.
11. In the Material Options, make sure the Import Inventor Materials and the Assign
Material IDs options are both checked.
12. We will keep the Mesh Resolution set to 0.
13. Lastly, set the Inventor File Vertical Direction to the Y Axis option.
14. Click OK and this will begin the import process.

Hierarchies for Animation
Hiding Background Elements
1. Open the layers dialog.
2. In the layer editor click to hide the Ground layer, the Lighting layer, and the Cameras
layer.
3. Close the layers dialog.

Grouping Objects and Assemblies
1. First, make sure the MV-22.iam object is selected. We want to make sure the objects
are not grouped already as a result of the import process.
2. From the Group menu, select Ungroup.
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3. Click off into space first to make sure you deselect any currently selected objects.
4. Then, using whatever method you desire, select the two vertical tail pieces, the
horizontal tail piece and the main fuselage.
5. From the group menu, choose group, and name the group "Fuselage", then click OK.
6. Then right click on the newly created group, and choose hide selected.
The Engine Nacelle Pivot Helper

7. Press ALT+W to change to a four viewport screen layout.
8. Click on the Create tab in the Command panel.
9. In the Create tab, choose the Helpers option.
10. Click the Point helper object.
Before creating the Point object, let's make a few changes to the parameters.
11. In the Display group, make sure the Axis, Cross, Box, Constant Screen Size and Draw
On Top checkboxes are checked.
12. Set the Size to 36.
13. To create the Point object, click once in the Top Viewport.
14. Once the Point is created, click the Modify Panel.
15. In the name type-in, change the name to "DMY_Nacelle_PVT" and press ENTER.
Positioning the Point helper.

16. With the DMY_Nacelle_PVT selected, press "W" to activate the Move tool.
17. In the Status bar at the bottom of the interface, set the X value to 0.0, the Y value to 1.472, and the Z value to 4.891.
Propeller Blade Rotation Helpers

18. Creating the Point objects.
19. In the Command panel, click the Create tab.
20. Choose the Point object.
21. In the Top viewport, click in front of the propeller on the left to create a point helper.
Then click in front of the right propeller to create the point for it.
Naming and Positioning the Propeller Helpers

22. You can prevent yourself from selecting any objects other than the helpers by setting
the Selection Filter to Helpers. Choose Helpers from the Selection Filter dropdown.
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23. With Point002 selected, click the Modify panel.
24. In the Name type-in "DMY_Prop_Left_PVT" and press ENTER.
25. Click the Select and Move icon from the main toolbar to activate the Move tool.
26. In the Status bar at the bottom of the interface, set the X value to 3.657, the Y value to
-3.267, and the Z value to 4.910.
27. In the Top viewport, select the Point001 helper object at the front of the right propeller.
28. In the Name type-in "DMY_Prop_Right_PVT" and press ENTER.
29. Activate the Move tool.
30. In the Status bar at the bottom of the interface, set the X value to -3.657, the Y value to
-3.267, and the Z value to 4.910.
Creating the Nacelle Link Helpers

31. In the Top viewport, select both Prop helper point objects.
32. Make sure the Select and Move tool in active from the main toolbar.
33. Holding the SHIFT key, place the cursor over the "Y" axis of the Move gizmo. Then, click
and drag up in the Top viewport to about mid way through the nacelle to create a clone
of each.
34. This will cause the Clone Options dialog to open. In the Object group, choose Copy, then
click OK.
35. Click on the "DMY_Prop_Right_PVT001" point object.
36. In the Modify panel, name type-in, rename the object to "DMY_Nacelle_Right" and
press ENTER.
37. Click to select the "DMY_Prop_Left_PVT001".
38. In the Modify panel, name type-in, rename the object to "DMY_Nacelle_Left" and press
ENTER.
Creating the Fuselage Dummy

39. Select the Create tab from the Command panel.
40. Choose the Helpers option.
41. This time, click the Dummy object.
42. On the Top viewport, click and drag to create the Dummy object.
43. Change to the Modify tab on the Command panel.
44. In the Name type-in, change the name to "DMY_Fuselage_POS" and press ENTER.
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45. Make sure the Select and Move tool is selected.
46. In the Status bar, position type-ins, set the X value to 0.0, the Y value to -1.7, and the Z
value to 4.0.

Setting up the Hierarchy
Linking the Helpers

1. From the Tools menu, click the New Scene Explorer option.
2. If needed, expand the Scene Explorer to be able to see all the objects in the scene by
clicking and dragging the bottom of the dialog.
3. Expand the Name column so that you can see the complete name by clicking on the
vertical separation line to the right of the name category heading and dragging to the
right.
4. Select the Display menu and make sure the Display Children option is checked.
5. To begin creating the hierarchy for the helper objects, click on the icon for the
"DMY_Nacelle_PVT" object and drag it over the "DMY_Fuselage_POS" object in the
list.
6. Click and drag the "DMY_Nacelle_Left" icon and position it under the
"DMY_Nacelle_PVT".
7. Click and drag the "DMY_Nacelle_Right" icon and position it under the
"DMY_Nacelle_PVT".
8. Click and drag the "DMY_Prop_Left_PVT" icon under the "DMY_Nacelle_Left" object.
9. Click and drag the "DMY_Prop_Right_PVT" icon under the "DMY_Nacelle_Right"
object.
Linking the MV-22 Objects to Helpers

10. First, unhide the Fuselage object.
11. Right-click in the Top viewport until the Quad Menu opens.
12. In the upper right quad, choose Unhide By Name.
13. In the Unhide Object dialog, double click the Fuselage object to unhide it.
14. In the currently open Scene Explorer, click on the Fuselage object icon and drag it on top
of "DMY_Fuselage_POS".
15. Next, click and drag the "Left_Nacel:1" icon on top of "DMY_Nacelle_Left".
16. Click and drag the "Left_Nacel_MIR2:1" icon on top of "DMY_Nacelle_Right".
17. Click and drag the "Left_Prop:1" icon on top of "DMY_Prop_Left_PVT".
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18. Finally, click and drag the "Left_PropMIR:1" icon on top of "DMY_Prop_Right_PVT".
19. Close the Scene Explorer.
20. Press W on the keyboard to activate the move tool
21. Then click and drag the DMY_Fuselage_POS in the Y axis back and forth.
22. Now press E on the keyboard to activate the rotate tool.
23. Set the Reference Coordinate System to Local.
24. Turn on the Angle Snap toggle in the Main toolbar.
25. This time, instead of rotating the dummy object for the MV-22, rotate the
DMY_Nacelle_PVT helper along its X axis -90 degrees. Click on the red X Axis ring and
drag the mouse up to rotate the helper.
26. Now select the DMY_Prop_Right_PVT, rotate it along its Y axis.
27. Press CONTROL+Z to undo the last rotation of the propeller.

Animating the Assembly
Setting the Display

1. Maximize the Camera001 viewport (ALT+W) so we can see what we’re doing a little
better.
2. Click the Layer Manager icon in the Main toolbar to open the Layer Manager dialog.
3. In the Layer Manager dialog, click the Hide option (Light bulb) for the Ground layer in
order to unhide the runway.
4. Close the Layer Manager.
Before we start creating key frames, let’s set the length of the animation.
5. Open the Time Configuration dialog.
6. In the Animation group, make sure the length is set to 900 frames.
Close the Time Configuration dialog.
Creating Keyframes

7. Select the DMY_Fuselage_POS object.
8. Then, turn on set key by clicking the Set Key button.
9. Click on the key filters option.
10. In the key filters dialog, uncheck Scale, and IK Parameters. Make sure only the Position
and Rotation filters are checked.
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11. Close the Set Key Filter dialog.
12. Click and drag the Time Slider to frame 250.
13. Then, click the Create Key button.
14. Drag the time slider over until you get to frame 500.
15. To make sure the DMY_Fuselage_POS object is not accidentally deselected, click the
Lock in the middle of the status bar.
16. Before we move the fuselage, change the Reference Coordinate System to World.
17. Click the Select and Move tool.
18. Now go ahead and move the DMY_Fuselage_POS object in the Z direction to about 6.0
units in Z.
19. Click the Create Key button again.
20. Scrub the time slider from frame 250 to 500 and we can see the aircraft lifting off the
runway.
21. Now scrub the Time Slider to frame 900.
22. In the Status Bar, change the Y value to -17.0 and the Z value to 7.0.
23. Click in the Create Key button again.
24. Scrub the time slider from frame 250 to 900 and we can see the aircraft lifting off the
runway then moving out of the frame to the right.
25. Click the Lock and deactivate it to be able to select another object.
26. Press the E key on the keyboard to activate the Select and Rotate tool.
27. Open the Key Filters dialog, turn off Position.
28. Drag the Time Slider back to frame zero.
29. Click on the Select the DMY_Prop_Right_PVT object.
30. Click the Create Key button to create the first rotational key frame.
31. Then drag the time slider to frame 200.
32. Rotate the point helper along the Z axis about 80 degrees.
33. Click the Create Key button to create the second keyframe.
34. Select the DMY_Prop_Left_PVT object.
35. Drag the Time Slider back to frame zero.
36. Click the Create Key button to create the first rotational key frame.
37. Then drag the time slider to frame 200.
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38. Rotate the point helper along the Z axis about -80 degrees.
39. Click the Create Key button to create the second keyframe.
40. Now select the DMY_Nacelle_PVT object.
41. Set the frame Time Slider to frame 550.
42. Click the Create Key button to create the first rotational key frame.
43. Change the Time Slider to frame 700.
44. Rotate the DMY_Nacelle_PVT along the X Axis 90.0 degrees.
45. Click the Create Key button to create the second rotation keyframe.
46. Turn off the set key option.

Editing Keyframe Timing
The Right Propeller

47. Change the Time Slider to frame 0.
48. Select the "DMY_Prop_Right_PVT" object.
49. Open the Curve Editor from the Main Toolbar.
50. In the Curve Editor, object hierarchy, click on the Y rotation controller.
51. Then select the first key frame.
52. Set its tangent to slow.
53. Select the second key frame.
54. Right click to open the Key Info dialog.
55. Click and hold the curve In option, and choose the linear option.
56. Set the Value to -3600.0.
57. Close the dialog
58. From the Edit menu, Controller option, click on Out of Range Types from the flyout
menu.
59. Click on the Linear Out only option.
60. Click OK to close the dialog.
The Left Propeller

61. Click to select the "DMY_Prop_Left_PVT" object.
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62. In the Curve Editor, object hierarchy, click on the Y rotation controller.
63. Then select the first key frame.
64. Set its tangent to slow.
65. Select the second key frame.
66. Right click to open the Key Info dialog.
67. Click and hold the curve In option, and choose the linear option.
68. Set the Value to 3600.0.
69. Close the dialog
70. From the Edit menu, Controller option, click on Out of Range Types from the flyout
menu.
71. Click on the Linear Out only option.
72. Click OK to close the dialog.
73. Close the curve editor.
74. Click Play to play the entire animation.

Rendering with the Quicksilver Hardware Renderer
Rendering the scene

1. Click the Render Setup button in the main toolbar to open the Render Setup dialog.
2. Make sure the Common panel is visible.
3. Set the Time Output to the Active Time Segment option.
4. From the Output Size dropdown, click on the HDTV setting.
5. In the Output Size area, choose the 480x270 resolution option.
6. In the Render Output section, click the Files... button.
7. In the Render File Output dialog, set the name to "MV22_.png".
8. Make sure that the save as type is also set to the .png image file format.
9. Click Save.
10. In the PNG configuration dialog, set the Colors option to RGB 24 bit.
11. Keep the Alpha Channel checked.
12. Open the Assign Renderer rollout.
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13. Click to select the Production Renderer option. (The button with three dots to the right
of the Production renderer name.)
14. From the Choose Renderer dialog, double click the Quicksilver Hardware Renderer
option.
Adjusting the Renderer Settings

15. In the Render Setup dialog, change to the Renderer tab.
16. In the Rendering Duration Per Frame group, set the Iterations to 32.
17. In the Lighting and Shadows area, set the Illuminate With option to Scene Lights.
18. Make sure the Shadows checkbox is checked.
19. Since we are not concerned with reflections, in the Reflections rollout, uncheck the
Reflections Checkbox.
20. And, we are not going to render with Depth of Field. In the Depth of Field rollout,
uncheck the Depth of Field checkbox.
21. Now press the Render button.
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